Inmagic® Genie 3.30 Installation Notes

Thank you for purchasing Inmagic® Genie.

Inmagic Genie is an integrated library system application that consists of a set of predefined textbases,
forms, and business logic to support library functions such as cataloging, acquisitions, circulation of
materials, serials tracking, interlibrary lending, and end user searching.

Sample system configuration

Web and Application Server

s File Server
; Ganie textbase support filas
CoiwebPublisher PRO Sofiware (GBS, INI, etc.)

Genie Application
MET Framework v3.55F1

. E——
—I
=]
¢
| -
i Desktops Waorkstations
Database Server CSTextWorks Software

S0L Server Express | MS S0L Server
Genie Texthases

Web Brawser

Figure 1: Sample system configuration
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System Requirements

In addition to the system requirements necessary for the Content Server product (refer to the Technical
Guidelines documentation, which you can find at the Inmagic Web site at http://www.inmagic.com), the
Genie application has the following system requirements. Note that these requirements are accurate as
of the original publication date for this document. For the most up-to-date system requirements, go to the
Inmagic Web site.

Server Requirements

Operating systems. One of the following operating systems:
o Windows 2003 with Service Pack 2
o0 Windows XP PRO with Service Pack 2

Content Server version 9.00, Service Pack 1 or later [Content Server v11.00 Recommended].
Content Server version 9.00, SP1 or later must already be installed and functioning properly before
you install the Genie application.

ISAPI. The Genie application only supports ISAPI.

Microsoft Internet Information Services (1IS) version 5.0 or later. This Web server software must
already be installed.

Microsoft .NET Framework Version 3.5 Service Pack 1. This software must already be installed
before you try to install the Genie application. Note that the installation program will not continue if it
does not detect .NET Framework version 3.5 Service Pack 1.

Microsoft Internet Explorer version 6.0 or later. This software is required on the server to support
the XML-dependent functionality of the Genie application. Internet Explorer must be installed on the
Web server machine before you try to install the Genie application. Note that the installation program
will not continue if it does not detect Internet Explorer 6.0 or later.

Client Requirements

Operating systems. One of the following operating systems:
o Windows Vista

0 Windows 2003 with Service Pack 2

0 Windows XP Professional with Service Pack 2

o Windows 2000 Professional with Service Pack 4

Screen resolution. We recommend a minimum screen resolution of 1024 x 768 pixels on the Web
browser machines that will access the application. You can specify this setting through the Windows
Display Properties dialog box. A smaller screen resolution can be used, but more scrolling will be
required in order to see the information on some screens.

Web Browser Support
0 Microsoft Internet Explorer version 6.0 or later.
o Firefox. Firefox is supported for the OPAC, for searching and viewing results.

0 Cookies must be enabled regardless of browser used.
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Before You Begin

Do the following before you begin

Verify that CS/WebPublisher PRO can search a textbase and edit a record before you install
the Genie application. If the CARS textbase was installed with CS/WebPublisher PRO, you can do
the following:

1. Point your Web browser to http://webservername/ics-wpd/sample/carsgs.htm. Fill in the name of
the Web server where CS/WebPublisher PRO resides.

2. Type an asterisk (*) in the Model Type: Assembled or Kit? box, then click the Submit Query
button. A successful search will display the search results.

From the drop-down list, select Prices (edit links).

Modify any field.

3

4. Select the Edit Record link for any record.

5

6. Click the Submit Record button. A successful record save message should appear.

CS/WebPublisher PRO must successfully do the above before you try to install the Genie application.
Exit all Windows applications. Exit all Windows applications before installing the Genie application.

Administrator access. Log in as Local Administrator or a domain user with local administrator
privileges before you start the installation process. If you are not logged in as an Administrator, Setup
detects it and a dialog box opens so that you can switch accounts (to an Administrator). The
installation cannot continue if you are not logged in as an Administrator or you do not have
Administrator privileges on the local machine.

Remote Access / Desktop. It is strongly recommended that you do not use remote access / desktop
to install this product.

Know the answers to or be aware of the following items before you begin

Validation override preference for Browse lists. You need to know your organization’s validation
override preference for the Genie application because you set this during the installation process.
Consult with your library administrator.

Sample textbases. You need to know if you have to install the Genie sample textbases. The library
staff may want to use the sample textbases to help familiarize themselves with the application.
Consult with your library administrator.

Serial number. Have your Genie serial number available. You will be asked for it during the
installation process.

Content Server configuration and authentication method. You should know which configuration
of Content Server you have (for example, Standard or Workgroup) and which SQL Server
authentication method it uses (Windows Authentication or SQL Authentication). Depending on this
information, you may have to specify/modify certain settings before you can use the Genie
application. This document details which settings must be set for each situation.

Note: By default, Content Server Standard uses Windows Authentication. Content Server Workgroup
uses SQL Authentication.

MARC Transformer for Inmagic® Content Server bundled with the Genie product. If your library
receives cataloging data in MARC communications format, you may want to install the MARC
Transformer. The transformer product comes with its own installation CD-ROM and installation
instructions if you receive the Genie product on CD. If you receive the Genie product via download,
you must call Inmagic Customer Service and request the CD for the MARC Transformer product. The
transformer helps you load MARC data into your Genie textbases. The transformer also helps you
provide your textbase data to others in MARC communications format.
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Installation Steps

The following are the steps to installing Genie version 3.30.
1. Installation of the Inmagic Genie version 3.30 software

¢ An installation folder is created for the Genie program files; plus a subfolder for the Genie
textbase files, as well as other subfolders required by the application.

e The virtual directory required by the Genie application is created and configured.
¢ You are prompted to select the 1IS authentication method for the Genie application.

e SOAP files necessary for Genie are copied to the Soap subfolder of the installation folder
for CS/WebPublisher PRO

2. Setting up security

You must assign rights and security for SQL Server, Windows folders, and the textbases.

3. Testing and wrapping up
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Step 1 - Installing Inmagic Genie 3.30

To install Inmagic Genie

1. Onthe Web server where you have CS/WebPublisher PRO installed, log in with Administrator
privileges (for example, Local Administrator or a domain user with local administrator privileges). It is
strongly recommended that you do not use remote access / desktop to install this product.

2. Because the application is a Web-based application, stop IIS (the World Wide Web Publishing
Service). For example, you can do this by using the Services option through the Windows Computer
Management window. Stopping IIS ensures that installation and configuration of the application are
not interrupted.

3. Depending on your situation, do the following:

= |f you are installing from the Inmagic Genie Setup CD-ROM, insert it in the drive of the Web
server machine where you have CS/WebPublisher PRO installed. Setup should automatically
start. If it does not, open Windows Explorer and from the installation CD-ROM, double-click
Setup.EXE.

= |f you are installing from an electronic download, after you download the Genie ZIP file, unzip it to
a temporary folder on the Web server machine where you have CS/WebPublisher PRO installed.
Then, from within that folder, double-click Setup.EXE to launch the program to install the Genie
application.

Note that the Setup program will not proceed if any one of these is true:
= Microsoft .NET Framework Version 3.5 Service Pack 1 is not already installed.

= Microsoft Internet Explorer 6.0 or later is not already installed.

4. Welcome

On the Welcome dialog box, click Next.

Inmagic® Genie 3.30

Welcome - ™

Welcome to the Inmagic Genie Setup Program. This program will install Inmagic Genie on
Your computer.

ou must ext all Windows programs before running the S etup program.

We STROMGLY RECOMMEMD that you follow the installation notes PDF file az you
inztall/upgrade the Inmagic Genie application. During the inztallation/upgrade process, you
will have to make decisionz for which this document provides guidance.

Unauthonzed reproduction or distribution of this program, or any portion of it, may result in
gevere civil and crminal penalties, and will be prozecuted to the masximum extent pozsible
under the: law.

Wiew Install Maotes |

Figure 2: Welcome dialog box

Cancel |

Inmagic Genie 3.30 Installation Notes Page 5



5. License Agreement

On the License Agreement dialog box, read the license agreement, and then respond appropriately.

Inmagic® Genie 3.30

License Agreement ‘

Pleaze read the follmwing license agreement carefully. I e .

INMAGIC LICEMSE AGREEMEMT Mworldwide) 3

IMPORTANT: READ THE FOLLOWING TERMS AMD CONDITIONS
CAREFULLY BEFORE ACCEPTIMG THIS LICEMSE AGREEMENT. THESE
TERMS AND COMDITIONS COMSTITUTE THE EMTIRE LEGAL AGREEMENT
BETWEEN 0L AMD INMAGIC, INC. CONCERMING THE PROPRIETARY
SOFTwARE PROGRAM AND THE ACCOMPANYING USER DOCUMENTATION.
BY FOLLOWwIMG THE APPROPRIATE RESPOMSE COMMANDS OR BY
SELECTING "I ACCEPT THE TERMS OF THE LICEMSE AGREEMEMNT",

Ol ARE COMSENTING TO YOUR ACCEPTANCE OF THESE TERMS AND
CONDITIONS AND INMAGIC, INC. SHALL FURNISH THE PROGRAM AND
DOCUMENTATION SUBJECT TO THESE TERMS AND CONDITIONS ALOME.

-
M AT M M T A e L ST L T LS P e TR U T IS T L L T _I

| accept the terms of the license agreement Print |

¢ i do not accept the terms of the license agreement

| stall=hield

< Back | et I Cancel |

Figure 3: License Agreement dialog box

6. Customer Information

On the Customer Information dialog box, enter your name and your company name, and the Genie
serial number, then click Next.

Inmagic® Genie 3.30 E3 |
Customer Information “
Fleaze enter your information. I e .

Fleaze enter your name, the name of the company for which you worl,
and the product zenal number.

Uszer Mame:

ILlser Mame

LCormpary M ame:

IEDmpan_l.J

Seral Mumber:
ISerial Mumbed

¢ Back | Meut > I Cancel

Figure 4: Customer Information dialog box
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7. Select Features
On the Select Features dialog box, select or clear the check boxes, as appropriate, then click Next.
= Program Files. Installs the Genie program files.

= Textbases. Provides the files needed to install the empty textbase files ready to accept your
data. You will have to install the textbases on the SQL Server before you can use them.

= Sample Textbases. Provides the files needed to install the sample textbases supplied with the
application. If selected, you will also have to install the textbases on the SQL Server before you
can use them.

Inmagic® Genie 3.30

Select Features il
Select the features Setup will install | - -

Select the features you want ta inztall, and dezelact the features you do nob want ba inztall

r Dezcription

Texthazes Inztallz Inmagic Genie.

Sample Texthases

16.62 ME of space required on the C diive
18044.18 MB of space available on the C dive
| stall=hield

< Back | Mest » I Cancel

Figure 5: Select Features dialog box

8. Choose Destination Location for Program Files

On the Choose Destination Location for Program Files dialog box, accept the default location
(C:\Program Files\Inmagic\Genie) or click the Browse button to change it. This is where program files
for the Genie application will be installed. These files must be installed on the Web server machine
where you have CS/WebPublisher PRO already installed.

Inmagic® Genie 3.30

Choose Destination Location for Program Files

Select the folder where Setup will inztall the program files. l -

Setup will ingtall Inmagic Genie in the Destination Falder belaw,

Tainztall ta this folder, click Mext. Toinstall to a different folder, click Browse and select
another folder,

Mote: Thesze files must be installed on the wWeb zerver machine where WebPublizher PRO
iz already installed.

C:\Program FileghnmagichGenie Browse... |

| stall=hield

" Drestination Folder

< Back Cancel |

Figure 6: Choose Destination Location for Program Files dialog box
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9. Choose Destination Location for Textbase Files

On the Choose Destination Location for Textbase Files dialog box, accept the default location
(C:\Program Files\Inmagic\Genie\Textbases) or click the Browse button to change it. This is where
Setup will install the Genie textbase files. Note that Setup will edit the CS/WebPublisher PRO
ICSWeb.INI file to point CS/WebPublisher PRO to this location for the Genie textbases.

Inmagic® Genie 3.30

Chooze Destination Location for Textbase Files ‘
Select folder where zetup will install Inmagic Genie Textbase Files. I i

Setup will inztall Inmagic Genie texthaze files in the destination folder below.

Tainztall ta this folder, click Mext. Toinstall to a different folder, click Browse and select
another folder.

Mate: Thesze filez can be installed on any machine where there is network. access ta them.

Drestination Folder
’7 C:\Program FilesMnmagichGeniehT extbazes Browse... |
| stall=hield

Canicel |

Figure 7: Choose Destination Location for Textbase Files
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10. Validation Overrides

On the Validation Overrides dialog box, specify whether the Genie application should accept or reject
validation overrides, then click Next.

= Yes, accept overrides and update lists. Select this option button to instruct the Genie
application to accept overrides and update the corresponding validation list. This is the
recommended choice.

= No, reject records that do not comply with content validation. Select this option button to
instruct the Genie application to not permit overrides.

Inmagick® Genie 3.30

VYalidation Dverrides %

Select whether Genie should accept or reject walidation

- i
overides, ‘ -

Wwiould you like to configure Genie to override content validation and update
walidation lists?

* *'es, accept overdes and update lists

£ Mo, reject records that do not comply with content walidation,

< Back I Mewnt > Cancel

Figure 8: Validation Overrides dialog box

If you later decide that you want to switch validation methods, see Inmagic Knowledgebase Article
2728.

11. Ready to Install the Program

On the Ready to Install the Program dialog box, click the Install button to start the installation. Wait
while Setup installs the files.

Inmagic® Genie 3.30

Ready to Install the Frogram W

The wizard is ready to begin inztallation. | - -

Click Inztall to begin the inztallation.

I wou want bo review or change any of pour installation settings, click Back. Click Cancel bo exit
the wizard.

|metallShield

Cancel

<Back |7 nstall”

Figure 9: Ready to Install the Program dialog box
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12. Virtual Directory Set-up

On the Specify Virtual Directory Settings dialog box, specify the settings you want to use with your
InmagicGenie virtual directory, then click Next.

= Available Web Servers. Specify the Web site on which you want to create the virtual directory
for the Genie application, which will be called InmagicGenie. This should be the same Web site
on which the ICS-WPD virtual directory was created for CS/WebPublisher PRO. Note that if
ICS-WPD is not there, Setup will create it.

= |IS Authentication. Select the authentication method you want to use with the Genie application.
For example, you can select Anonymous Access with or without SSL or you can use Integrated
Windows Authentication [Single Sign-on] to bypass the user login screen.

Inmagic® Genie 3.30
Specify Yirtual Directory Settings

Specify the zettings you want to uze with pour
‘InmagicGenie’ and ‘InmagicBrowse’ virtual directonies.

Specify the ‘Web site on which to create the InmagicGenie’ virtual directow, Mate: This must be the same
‘Web site on which the ‘ics-wpd' virtual directary was created for C5. webPublisher PRO.

Available Web Sites: 115 Authentication

Specify the authentication method pou want ta use with your
Genie installation.

& Anonymous Socess
" |ntegrated Windows Authentication [Single Sign-on)

" Basic Authentication

[~ Use 5L [Use https)

Figure 10: Specify Virtual Directory Settings dialog box

Important! Do not select Integrated Windows Authentication (Single Sign-on) unless both of the
following are true:

e The ICS-WPD virtual directory for CS/WebPublisher PRO has Anonymous Authentication
selected.

e The INMCSRV.INI file in the CS/WebPublisher PRO installation folder has
WindowsAuthentication=1

13. Informational Messages

A message appears to provide information regarding the Web.Config file.

Remote Control

Inmagic® Genie - InstallShield Wizard
wersion of this file. If vou made any modifications to this file, wou can copy them from the file

C:\Program Files\Inmagicy CSWPPInmagicErowseiweb, Canfigad,
which is also in the InmagicBrowse installation Folder,

i:) Setup has renamed the Web, COMFIG filz in your InmagicBrowse installation Folder and provided vou with a newer
oy

Figure 12: Web.CONFIG information message
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14. ICSWeb.INI File Edit

During the installation, Setup edits the ICSWeb.INI file. CS/WebPublisher PRO uses the information in
this file to locate the Genie textbases (the textbase path you chose in step 9 on page 8). For example, if
you accepted the default location, Setup updates the .INI file to point to C:\Program
Files\Inmagic\Genie\Textbases.

Note that if Setup determines that textbases with these names already are listed in the ICSWeb.INI file,
Setup will not write those Genie textbase names to this file. If this is the case, a message box will appear
with the duplicate textbase names listed. If this is a new Genie installation, rather than an upgrade from
an earlier version, note these textbase names. You will have to manually modify the .INI file to indicate
the path to the textbases that the Genie application will be using. All the Genie textbases must be listed in
the ICSWeb.INI file for the application to be able to function properly. Click OK to dismiss the message
box.

15. Installation AImost Complete

On the Installation AlImost Complete dialog box, select or clear the checkboxes for View the
README and Check for Service Packs, as appropriate, then click Next.

Inmagic® Genie 3.30

Installation Almost Complete -

¥ Check for Service Packs

Figure 13: Installation Almost Complete dialog box

If you selected the View the README check box, read or print the file, then close it to continue with
the installation.

If you selected Check for Service Packs, your Web browser will open to the Inmagic Customer
Extranet Service Pack page. We recommend that you check for the latest service pack. Click Finish.
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Inmagic® Genie 3.20

Inzstall5hield Wizard Complete

Setup has finished installing lnmagic® Genie 3.20 on your
computer.

Click Finizh to complate Setup.

< Back TFinish Y LCancel

Figure 14: InstallShield Wizard Complete dialog box

16. In step 2, you stopped IIS. IIS (including the World Wide Web Publishing Service) will be restarted
when the installation is completed.

Note: If needed, a different InstallShield Wizard Complete dialog box will appear, recommending that
you restart your computer when you click the Finish button. If you see this dialog, you must reboot
your computer before using the application.
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17. Installing Genie Textbases on your SQL Server

Note: This section is for new Genie installations only. Skip to Step 3 — Testing and Wrapping Up if this
is an upgrade.

Before you can use any of the Genie textbases, you must install them on your SQL Server. During the
installation process, one or more backup file sets for the Genie textbases were copied into subfolders
under your Genie installation folder.

Note that these instructions assume you accepted the default locations when you installed the
application.

e Textbase Backup_File_Set. The files in this subfolder contain no records (except in the GENIEKEY
and SUPPLIER textbases) so that you can load your own records into them. The default path is
C:\Program Files\Inmagic\Genie\Textbases\Textbase Backup_File_Set. The files in this subfolder
must be restored to the Textbases subfolder (default is C:\Program Files\Inmagic\Genie\Textbases).

Note for Genie Express installations: Only restore the CATALOG and GENIEKEY textbases. No
other textbase is required for Genie Express.

e Sample Backup_File_Set. The files in this subfolder are the same as in the
Textbase Backup_File_Set subfolder mentioned above—except that they are populated with sample
data so that you can use them to familiarize yourself with the application. The default path is
C:\Program Files\Inmagic\Genie\Textbases\Sample\Sample_Backup_File_Set. The files in this
subfolder must be restored to the Sample subfolder (default is C:\Program
Files\Inmagic\Genie\Textbases\Sample). This subfolder was created during the installation process
when you selected the Sample Textbases check box in step 8.

Tip! If your SQL Server data is located on a machine other than the one on which CS/TextWorks is
installed, you can either make the Textbase Backup_File_Set and Sample_Backup_File_Set subfolders
shared before installing the respective textbases, or you can access these files from the Textbases folder
located on the top level of the installation CD-ROM/download.

a. Log in with Administrator privileges (for example, Local Administrator) and start the Content Server
Administration program (InmCSAdmin.EXE) on the Web server machine where
CS/WebPublisher PRO is installed.

InmCSAdmin.EXE is located in its Exec subfolder (for example, C:\Program
Files\Inmagic\ICSWEB\Exec).

b. If the User File Path dialog box opens (only appears the very first time you run the software on that
machine), specify where you want to create user files and temporary files, then click OK. You can
accept the suggested path or specify a different one. You need full rights to whichever folder you
specify.

c. Choose Back Up & Restore>Restore Textbases to open the Restore Textbase Options dialog box.

d. Inthe Backup set box, use the Browse button to enter the path to a backup file set from either the
Textbase Backup_File_Set subfolder or the Sample_Backup_File_Set subfolder.

Important! If your SQL Server instance is located on a machine other than the one on which
Content Server is installed, you must also do the following:

= Use the Universal Naming Convention (UNC) file path to the backup file set using the format
\\Server\Share\Backups (for example, \\<server name>\VOL1\Textbases\
Textbase Backup_File_Set\Borrower.CBA).

= Use specific login parameters for the SQL Server service. The account must be a domain user on
the domain server (but does not need to be a member of any domain Admin group). This account
should be a part of the local Admin group on the SQL Server machine. (To do this, right-click the
My Computer icon on your desktop and select Manage. Expand the Services and Applications
tree, then double-click Services. Right-click your instance of SQL Server for the Genie
application, and select Properties. Select the Log On tab and then specify the account.)
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i. Click the Browse button and navigate to the applicable Backup_File_Set subfolder (for example,
C:\Program Files\Inmagic\Genie\Textbases\Textbase_Backup_File_Set or
C:\Program Files\Inmagic\Genie\Textbases\Sample\Sample_Backup_File_Set).

ii. Select one or more textbases (for example, Borrower.CBA), then click Open.
You can select more than one textbase at this point. We recommend that you select all of them.
e. Inthe Restore path box, click the Browse button and navigate to the appropriate folder:

= |f you are restoring from the Textbase_Backup_File_Set subfolder, restore to the Textbases
subfolder of the Genie installation folder (for example, C:\Program
Files\Inmagic\Genie\Textbases).

= |f you are restoring from the Sample_Backup_File_Set subfolder, restore to the Sample
subfolder (for example, C:\Program Files\Inmagic\Genie\Textbases\Sample). Be sure you
restore the sample textbases into the Sample subfolder. If you restored the textbases in
Textbase Backup_File_Set into the Textbases subfolder first, you must change the path in
the Restore path box to the Sample subfolder.

Important! If you decide to use the sample textbases, you must manually change the
ICSWeb.INI file to point to them in the Sample subfolder. You cannot point to the real and
sample textbases in the ICSWeb.INI file at the same time; only one set of Genie textbases
can be specified in the INI file.

f.  After all the textbases have been restored, proceed to Step 2- Setting Up Security.
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Step 2 - Setting Up Security

If either of the following applies, security must be set up before anyone can access the Genie application.

e You selected Integrated Windows Authentication or Basic Authentication when setting up the
InmagicGenie virtual directory (step 12). See Setting Windows Permissions on Folders.

e Content Server is using Windows Authentication when accessing SQL Server. See Assignhing

User Rights to Textbases.

Setting Windows Permissions on Folders

If you selected Anonymous Authentication when setting up the InmagicGenie virtual directory (step 12),
the Genie install will assign the necessary Windows rights to the folders. Proceed to either Assigning

User Rights to Textbases (if Content Server uses Windows Authentication when accessing SQL
Server) or Step 3 — Testing and Wrapping Up (if Content Server uses SQL Authentication).

If you selected Basic Authentication or Integrated Windows Authentication, you must set Windows
permissions for Genie users on the folders as described in this section.

Set Windows permissions for Genie users on the Textbases subfolder

You must set specific Windows permissions on the Textbases subfolder (or wherever you installed
the Genie textbases) to allow users to search and/or modify your textbases. Do this for the folder

where you installed the Sample textbases also, if necessary.

Note that the instructions and illustrations in this section are for a Windows 2003 machine.

a. Right-click the Textbases subfolder (for example: C:\Program Files\Inmagic\Genie\Textbases), or
wherever you installed the Genie textbases, and click Properties from the shortcut menu to open

the corresponding Properties dialog box.

b. On the Security tab, in the Group or User Names list, select a domain user/group account that
will be using the Genie application. If the account you want is not there, click the Add button and

do the following; otherwise continue with step 8.

21

Textbases Properties

Generall Sharing  Security IWeb Shalingl Customizel

Group or uger names:

ﬂ Administrators [DOCTEST 03 Administrators)
€7 CREATOR OWNER

ﬂ Power Usgers [DOCTESTOMWPower Users)
€7 SYSTEM

T TERRIKAIL CERWVER IISER
A

I

| o

FRemove |

Permizsians for Administrators Allows Deny
Full Control O =
Wadify O
Fead & Execute O
List Folder Contents O
Read O
Write O LI

For gpecial permizzions or for advanced gettings, Advanced |
click &dvanced. =

oK | Cancel I

Apply

Figure 14: Textbases Properties dialog box

c. If necessary, click the Locations button to open the Locations dialog box and select the

Windows domain.
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d. When your Windows domain is showing in the From this location box, click the Advanced
button to open the Select Users or Groups dialog box.

Select Users or Groups

Select this object pe:

ILlsers, Groupsz, or Built-in gecunty principals Object Types...

From this location:
IDDETESTDS Locations. .

Enter the object names to select [examples):

It

Lheck Hames

[k | Cancel

P

Figure 15: Select Users or Groups dialog box for Textbases subfolder

e. Click the Find Now button to display a list of your user/group accounts in the Search results
box.

f.  Select the user/group account from the list, then click OK.

Select Users or Groups 2|

Select this abject type:

ILIsers, Groupz, or Builtin zecurity principals Object Typpes... |

From this location:
IDDCTESTDS Locatians... |

Common Cueries |

Mame; IStarts with ~ | I Columns... |
Descriptiors. [Starts with 7] | | Find Mow |
I~ Disabled accounts Stop |

= Mo expiting password

[ays since |ast [ogan; I 'I @

Cancel |
Search results:
Name [RON] " In Folder [ B
€ IUSR_DOCTESTOR DOCTESTO3 =l
€ s DOCTESTO3 DOCTESTO3 LI

Figure 16: Select Users or Groups dialog box expanded for Textbases subfolder
g. Click OK again to return to the Textbases Properties dialog box.
h. Check the Modify & Write check boxes for the selected or newly-added account.

i. If Content Server is using Windows Authentication, proceed to Assigning User Rights to
Textbases. If Content Server is using SQL Authentication, proceed to Step 3 — Testing and
Wrapping Up.
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Assigning User Rights to Textbases
If Content Server uses Windows Authentication to access SQL Server, the following need to be set up:
0 Assign User Rights to SQL Server

0 Assign User Rights to the Genie textbases

1. Assign User Rights to SQL Server

a. Start the Content Server Administration program (InmCSAdmin.EXE). If you are on the Web
server machine where CS/WebPublisher PRO was installed, this file is located in its Exec
subfolder (for example, C:\Program Files\Inmagic\ICSWEB\Exec).

b. Choose Configure SQL Server>Manage Security>Assign User Rights to SQL Server.
c. Onthe Assign User Rights to SQL Server dialog box, click the Add User button.

M Assign User Rights to SOQL Server: 05¥YSW2K31GB'YS PRESTO ﬂ

Databaze: _|nmT exthazes
Current Databaze Users:

Femowve Lser |

Login Marme:
Privileges:

|Jze this dialog box to select Content Server uzers who will have textbase access. Members of
db_owner ar uzers with syzadmin privieges need no Content Server rale membership.

— Properties
Eantent Server rale membership
1 Hone ) Content Serven Administrator

' Content Server Lzer

ssigh the selected uzer a Content Server rale memberships & uzer must be & member
of arie of these rales to access am Eantent Server fextbhase,

Apgly |
LCloze | Help |

Figure 21: Assign User rights to SQL Server dialog box

d. Onthe Add Database User dialog box, depending on your situation, do the following. Note that
the Windows user/group must have a login on the SQL Server.

= For Anonymous Access or Integrated Windows Authentication, select the Anonymous
Access user for the ICS-WPD virtual directory from the drop-down list and click OK.

= For Basic Authentication, select the group containing Genie users from the drop-down list
and click OK.

Add Database User

Login Mame: |{aisgy2=gieiini=s]

[Miate: Current users are mot shown,

User Name: |DDETESTI33\IUSFE_DEIETESTEIE

0k I Cancel | Help |

Figure 22: Add Database User dialog box

Tip! If your SQL Server is on a different machine than the Genie application, you must use a
domain account for Anonymous Access, rather than the IUSR account.
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e. Onthe Assign User Rights to SQL Server dialog box, assign the Windows user/group selected in
the Current Database Users list to the appropriate role membership for the Windows user/group,
then click the Apply button. If you are assigning individual users, repeat steps c-e.

Set Security on S0L Server: DOCTESTO3)ics_msde 5[

Databaze: _|nmTextbazes
Current Databaze Users:

DOCTESTO3WUSAE DOCTESTO3 Add User. . |
Remowve User |

Login Mame: DOCTESTOSMUSKE_DOCTESTO3
Privileges:

|Use thiz dialog box to manage users of the control databasze. A “Windows group or user must
be a user in thiz database to access any Content Server databaszes. Members of db_owner or
uzers with syzadmin privileges need no Content Server role membership.

— Properties

Content Server role membership
" None " Content Server Administrator

&' Cantent Server Uger

heze roles to access any Content Server databaze. Other role memberships are not

zzign thiz uzer a Content Server role membership, & uger must be a member of one of
I
managed here.

Cloge | Help |

Figure 23: Assign User Rights to SQL Server dialog box with example
f. Click Close.
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2. Assign user rights to the Genie textbases.

You must specify security settings for all the Genie textbases in the installation folder. You must do this
for the empty Genie textbases in the folder in which you installed the Genie textbases. If you plan to
use the textbases in the Sample subfolder, then you would have to do this for those textbases too.

These security settings assign your users/groups (specifically, their domain accounts with logins on
the SQL Server) membership to roles granting varying degrees of access to the textbases on the
SQL Server.

a. Start the Content Server Administration program (InmCSAdmin.EXE). If you are on the Web server
machine where CS/WebPublisher PRO was installed, this file is located in its Exec subfolder (for
example, C:\Program Files\Inmagic\ICSWEB\Exec).

b. Choose Configure SQL Server>Manage Security>Assign User Rights to Textbase to open the
Select Content Server Textbase dialog box.

c. Select a Genie textbase from the folder in which you installed the Genie textbases (for example,
C:\Program Files\Inmagic\Genie\Textbases) and click Open.

d. On the Assign User Rights to Textbase dialog box, click the Add User button.

Il Assign User Rights to Textbase: Catalog EI

Database: _|nmTB_B3
Current Database Users:

Remove [ser |

Lagin Narme:
Frivileges:

Lze thiz dialog box to manage users of this Content Server databaze. & Windows group or
user must be a user in thiz database to access it Members of db_owner ar users with
zyzadmin privileges need no Content Server role membership to access this databage.

 Fropertie
™ Membenaf dby owner

I ernbership i this fised role allows the selected usento access
thiz database and perform &l operations and administrative
funchions,

Cantent Semver rale membership
" Hone " Garitent Server Data Writer

"' Caritert Server Beader {" Caritent Server Textbase Writer

Ione of these roles to aceess this databasze, Other role memberships are nat

ssign the selected user a Content Server rale membership. & user must be & member,
o
managed here,

£pply |
Close | Help |

Figure 24: Assign User Rights to Textbase dialog box
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e. Onthe Add Database User dialog box, select a Windows user/group from the drop-down list (for
example, IUSR_<Machine Name>). The Windows user/group must have a login on the SQL
Server.

= For Anonymous Access or Integrated Windows Authentication, select the Anonymous Access
user for the ICS-WPD virtual directory from the drop-down list and click OK.

= For Basic Authentication, select the group containing Genie users from the drop-down list and
click OK.

Add Database User x|

(LGB ERD OCTESTOALUSE DOCTESTO3

[Nate: Current users are not shown,

User Name: IDDETESTDS\IUSH_DDETESTDS

QK I Cancel | Help |

Figure 25: Add Database User dialog box

Tip! If your SQL Server is on a different machine than the Genie application, you must use a
domain account for Anonymous Access, rather than the [IUSR account.

f.  On the Assign User Rights to Textbase dialog box, assign the Windows user/group selected in the
Current Database Users list to the appropriate role membership for the Windows user/group, then
click the Apply button.

M Assign User Rights to SOQL Server: 05¥YSW2K31GB'YS PRESTO ﬂ

Databaze: _|nmT exthazes
Current Databaze Users:

Femmye [ zer |

Login Marme:
Privileges:

|Jze thiz dialog box to select Content Server uzers who will have textbasze access. Members of
db_owner ar uzers with syzadmin privieges need no Content Server rale membership.

— Properties
Eantent Server rale membership

' None £ Content Server Sdministratar

1 Content Sepver User

fane of these rales to access any Eontent Server texthase,

Apgly |
LCloze | Help |

Figure 26: Assign User Rights to Textbase dialog box with example

’Assign the selected uger a Content Servenrole membership! & user must be & member
e

g. Repeat steps d—f for each Windows user/group that should have access to the Genie textbase
selected in step c. When done, click the Close button.

h. Repeat steps c—g for each textbase in the folder in which you installed the Genie textbases.
i. Repeat steps c—g for each textbase in the Sample subfolder, if necessary.

j- When done, close the Select Inmagic Content Server Textbase dialog box and close the Content
Server Administration program.

k. Proceed to Step 3 — Testing and Wrapping Up.
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Step 3 - Testing and Wrapping Up

This section shows you how to make sure your Genie application is accessible. In addition, it tells you
how to change the default content page. It also suggests how to wrap up the installation.

To test access to the Genie application

After you have completed the installation of the Genie application, perform the following test to make sure
the application is accessible. If any of these steps fails, then there may be a problem with the installation.
If an error message appears anywhere during this test, check the Inmagic Knowledgebase. You can
access the Knowledgebase through the Inmagic Customer Extranet at
http://support.inmagic.com/downloads/extranet.html. Make a note of the exact text of the message or
print the page in case you need to contact Inmagic Technical Support.

1. Open your Web browser and point to http://WebServerName/InmagicGenie. Fill in the name of your
Web server where the Genie application resides. The InmagicGenie virtual directory was created
when you installed the application.

2. Log in by typing a username and password combination of “admin”/*admin”. The password is
case-sensitive. This is the highest-level default username/password combination. We strongly
recommend that you change the password at your earliest convenience. To learn about the other
default username/password combinations, how to change passwords, and other security features,
see the Inmagic Genie Security Notes.

3. Choose Suppliers>Search Suppliers.

Note: If you are using Genie Express, you will not have a Supplier Search page. However, you can
perform a similar test using the Catalog Search page.

4. On the Supplier Search page, click the Browse button next to the Company Name box, select a
Supplier from the list, and click the Add button. Do this multiple times if you like. When you are
finished selecting Suppliers, click the Close button.

5. Click the Submit Query button.
6. On the Search Results page, click the Edit link for any Supplier record. Supplier information should
appear for the record (for example, there is a company name, address, and Web site URL). Note that

not all boxes for the record may be filled in, but some information should appear for the record.

7. On the Edit Supplier Record page, make a mental note of the current value in the State/Province box,
then click the [Browse] link for the box, select an item from the list, and click Replace All.

8. Click the Save button. Verify that Record updated successfully. appears in the messages area of the
page.

9. Change the contents of the State/Province back to the original value, and click Save again.
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To change the default content page

Out of the box, after you log in, the Genie application opens the Catalog Search page
(catalog_search.ASPX). You can change this if you want.

1. Goto lIS, right-click the InmagicGenie virtual directory, and select Properties to open the
InmagicGenie Properties dialog box.

2. Select the Documents tab.

3. Remove the catalog_search.ASPX entry.

E Computer Management - nmagicGenie Properties ﬂll _|O ﬂ

(=) File Action Wiew Window Help Virtual Direckory  Documents | Directory SecuritylHTTPHeaderslCustDmEerrsl |;|ili|
e~ | OEXxXERE @(2]> =

[=] ?5 Internet Infarmation Services (115) Manager_l
[ Application Paols

El_J Wieb Sites

B & Dafault Weh Site
-- ‘t’ ics-wpd
B o Inmagiczenie

¥ Enable default content page

Mane U [awe Down |

1 Enable document Footer

@ Bin
_J ConfigFiles

_J Documentation
) DocurmentFolder
) ImageFaolder
_J images

_J ImportFolder
) scripts

) Seripty

) Texthases

) usercontrols
Bl ) WebHelp

- aspnet_client

Bl webctrl_clignt

Bl Web Service Extensions =

Append an HTML Formatted Footer ko every document your \Web
SErVEr Tetumms.

| BrOWse.. .

I;;._..;.;;.'_.LU_U_LLU_LLH;

il

[s]4 | Cancel | Aply | Help |

Figure 32: Inmagic Genie Properties dialog box with Documents tab

4. Add the .ASPX file you want as your default page.

For example, if you check out loans frequently, you may want to default to the Check Items Out page; add
the loans_checkout. ASPX file. For the names of the .ASPX pages, see the root of your Genie installation
folder. The pages are easily identifiable by their file names, which generally follow the format of

textbase name_function.ASPX.
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To wrap up the installation process

After successfully testing access to the Genie application, wrap up the installation process by telling your
library administrator:

e Where you installed the Genie application and its textbases. The library administrator will need to
know this to be able to access the Genie README file, which is also available from the Inmagic
Customer Extranet.

e To read the README file. This file, located in the Documentation subfolder of the main Genie
installation folder, provides information that the library administrator will need to know, including how
to set up the application with the library data for your organization and how to access the application.

e If necessary, to edit the ICSWeb.INI file to point CS/WebPublisher PRO to the appropriate set
of Genie textbases. The library administrator will have to edit the ICSWeb.INI file if she or he
decides to use the set of Genie textbases other than what was chosen during the installation of the
product. For example, the library administrator may later decide to point to the sample textbases for
training purposes. To do this, you have to edit the ICSWeb.INI file. You cannot point to the real and
sample textbases in the ICSWeb.INI file at the same time; only one set of Genie textbases can be
specified in the INI file. The library administrator may have to work with the Web server administrator
to update the .INI file.

e The username/password combination of “admin/admin” that gives the highest-level access to
the application. To be able to log in to the Genie application, the library administrator needs to know
this username/password combination. We strongly recommend that you change the password at your
earliest convenience. To learn about the other default username/password combinations, how to
change passwords, and other security features, see the Inmagic Genie Security Notes. For example,
to take advantage of Windows Authentication enabling the login bypass feature, you need to add user
login names to the Genie application.

e For non-U.S. installations, to specify the correct date and currency options. This involves
setting the culture in WEB.CONFIG, and the correct date format in DBTEXT.INI and MyGenie.Config.
See the Inmagic Genie Technical Notes for instructions.

About Other Installations

When displaying labels or a report designed for printing for the first time, the end user will be prompted to
install the ScriptX software that provides the Genie application with more control over printing (this
software, for example, adjusts margins correctly depending on what you are printing, it suppresses the
Web browser’s headers and footers, and it allows for specifying page breaks for long reports). This
message will appear the first time this software is needed on a workstation. Once the software is
installed, the end user will not encounter the message again on that workstation.

To install the ScriptX software, click the Install (or Yes) button that appears on the message box.

Once the labels or report appear on a page, the end user can use the print mechanism for the Web
browser to print the page (for example, choose File>Print).
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Genie 3.30 Features Not Enabled

The following features are not enabled out-of-the-box, for the reasons given below. If you choose to
enable these features, follow the instructions below. Note: To reload .CONFIG files after modifying them,
click the Reset button on the window that opens after clicking the About Genie link at the top of the
Genie menu.

e Alternate OPAC Search screen

Reason: This search screen uses a different method to evaluate search criteria than the other search
screens in Genie. For example, users can type words without specifying an & symbol between them
to find any records including all of the words.

To enable: Modify the following section at the bottom of the MyQueries.CONFIG file to include the
bold line.

<l-- ** Note: Use special TextbaseName="Opac" to specify the screens listed in the opac.aspx -->
<inmg:QueryScreens TextbaseName="Opac">
<inmg:QueryScreen Name="alt_opac_search"></inmg:QueryScreen>
<inmg:QueryScreen Name="simple_opac_search"></inmg:QueryScreen>
<inmg:QueryScreen Name="opac_search"></inmg:QueryScreen>
</inmg:QueryScreens>

Tip! You may also want to remove the other <inmg:QueryScreen> lines in the section shown above
so only this screen is available, and modify the Title= value below in the query screen definition.

<inmg:QueryScreen Name="alt_opac_search" Title="Alternate Catalog Search"
AlternateSyntax="true">

e Patron self-service

Reason: Some libraries do not want patrons to be able to check out and/or renew library materials
themselves.

To enable: Self-checkout is available to OPAC users if the <OpacPages> element in
MyGenie.CONFIG contains the page name opac_checkout.aspx. Self-renewal is available to OPAC
users if that element contains the page name opac_loans_search.aspx. Add or remove the
appropriate page(s) to enable or disable one or both of these features.

In addition to the pages listed in MyGenie.CONFIG, links to the pages in question are needed outside
of the Genie application. Add the appropriate links to your intranet, and/or publish the URLSs of private
versions of these pages for OPAC users to add to their browser Favorites. For more information,

see the Inmagic Genie Technical Notes.

e Table of Contents upload and routing

Reason: Many customers are unlikely to use this feature. Also, in order to extract text from a Table of
Contents PDF file and make it searchable, the CS/Importer has to be set up properly.

To enable: The Serials edit screen definition in MyEditScreens.CONFIG includes a commented-out
section for uploading a ToC image (not a document). Find that section near the end of the definition
and remove the comment characters. Also consider exposing links to the Table of Contents images
in reports. See the commented-out <ltemlnfo..> section in the CatalogFull report in
MyReports.CONFIG for an example.

Page 24 Inmagic Genie 3.30 Installation Notes



e My Genie pages for end-users

Reason: The GenieKey textbase needs login records for each user and borrower IDs added before
this feature can be enabled and used.

To enable: In MyGenie.CONFIG, look for the commented-out element OpacMyGenie. Remove the
comment characters.

e |tems searching for end-users

Reason: End users are unlikely to need to search for Item records, unless they are searching the text
extracted from tables of contents.

To enable: In MyGenie.CONFIG, look for the commented-out element OpacSearchltems. Remove
the comment characters.

e Bulk Item record generation

Reason: This feature was implemented to enable efficient creation of Item records for hundreds of
volumes associated with a single Catalog record. U.S. law libraries, for example, may order the
Federal Reporter, which contains close to 1000 volumes.

To enable: In MyEditScreens.CONFIG, look for the commented-out element <Button
Name="'Generateltems" ..>. Remove the comment characters. If you plan to create large
numbers of Item records, also consider limiting the number that appear in specific circumstances.
See descriptions of the Al lowPaging attribute in MyEditScreens.CONFIG, and the Max1tems
attribute in MyReports.CONFIG in the Inmagic Genie Technical Notes.

e Bar code label report
Reason: The "Free 3 of 9" font that is used in the report must be downloaded and installed on any
workstation that will be printing bar code labels, before this report can be used. See instructions in

the Genie help.

To enable: In MyReports.CONFIG, look for the ReportList for the Items textbase. Find the
commented-out element <Report Name="BarcodeTriple3x10" ...>. Remove the comment characters.
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Enabling Genie 3.30 Features for Upgrades

For customers upgrading from Genie version 3.20, a number of new Genie 3.30 features require
copying information from the non-My version of the .CONFIG file to the corresponding MyXXXX.CONFIG
file, as described below. Please see the previous section, as well.

Tip! See Inmagic Technical Support Knowledgebase #3006 for information on using third-party tools to
make this process easier.

Textbase changes
The following changes require opening each textbase in TextWorks.

Serials textbase — Choose Maintain>Edit Textbase Structure, then click the Edit Fields button.
Note: Exclusive access to the textbase is required to use Edit Textbase Structure.
Select the SerDateToRoute field, uncheck Require Strictly Correct Type in the Type Information
group, and click Change. Select the SerClaimHistory field, select Date from the Field type drop-
down list in the Type Information group, and click Change. Click Finish, then OK.

Catalog textbase — Choose Display>Design Form, then select the WebPrint form. Select the third
box on the form (the second red box), and choose Tools>Box Properties. For the first Fixed Text
item in the Contents list, remove the <b> from the end of the string. Click the Replace button then the
Close button, then choose Form Operations>Save Form.

Edit new Serial record from the Edit Catalog Record page (MyEditScreens.CONFIG)

On the Edit Catalog Record screen, after clicking the Create Serial Record link on the Serials tab, a
new Edit Serial Record link will appear. When you click this link, the Set Up Serial Arrival Pattern
screen appears in a pop-up window. To enable this feature, make the following change to
MyEditScreens.CONFIG in the catalog_edit screen.

Add this link to your existing Edit Catalog Record screen by copying the following section from the
catalog_edit screen in EditScreens.CONFIG and pasting it into the same location in
MyEditScreens.CONFIG.

<Field>%%StartRow</Field>
<Field Display="Edit Serial Record" Style="font:normal" Align="Center">%%EditSerial</Field>
<Field>%%EndRow</Field>

Set Up Serial Arrival Pattern changes (MyEditScreens.CONFIG)
Make the following changes to the serials_setup screen in MyEditScreens.CONFIG.

Add the new Save All and Close buttons to the Data Entry toolbar. Save All is used when updating
the arrival pattern in all Serial records for the same Title. Close only appears when the page is
launched using the new Edit Serial Record link on the Serials tab of the Edit Catalog Record page.

<Toolbar Title="Data Entry Toolbar" ButtonCellWidth="250">
<Button Name="GenerateDates" Text="Generate Dates"/>
<Button Name="Add" Text="Add Record"/>
<Button Name="Save" Text="Save"/>
<Button Name="SaveAll" Text="Save All"/>
<Button Name="Duplicate" Text="Duplicate"/>
<Button Name="Duplicate" Text="Duplicate"/>
<Button Name="PrevRecord" Text="Prev"/>
<Button Name="NextRecord" Text="Next"/>
<Button Name="Close" Text="Close" />
</Toolbar>
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To automatically clear the Routing List box when creating a duplicate record on the Set Up Serial
Arrival Pattern screen, add the ClearOnDuplicate="true" option shown below.

<Field Name="SerRouteList" Type="TextBox" CssClass="serials_edit_textinput"
ClearOnDuplicate="true" Width="50%" NumLines="5" ShowBrowse="true"
BrowseType="FIELD_VALUE" BrowseTN="Borrower" BrowseField="BorrName"></Field>

Remove Required="true" from the Start Date, Duration, and Frequency boxes, as shown below.

<Field Name="SerDateStart" Type="TextBox" CssClass="serials_edit_qtr_textinput" Width="174"
ShowCalendar="true"/>

<Field Display="Duration (months)" Type="TextBox" CssClass="serials_edit_qtr_textinput"
Width="174" ToolTip="Enter the number of months in the duration of the
subscription.">%%SerialDuration</Field>

<Field Name="CatSerFrequency.SerCatID" Display="Frequency" Type="DropDownList"
CssClass="serials_edit_gtr_textinput" Width="174"></Field>

e Edit Serial Record screen changes (MyEditScreens.CONFIG)

Edit the serials_edit screen in MyEditScreens.CONFIG to add a new Set Up Arrival Pattern button
under the existing NextRecord button.

<Button Name="Setup" Text="Set Up Arrival Pattern" NewRow="true" />

Also, change the NumLines for the SerNotes field to “2” as shown below.

<Field Name="SerNotes" Type="TextBox" CssClass="serials_edit_textinput" NumLines="2"></Field>
e Table at bottom of Edit ltems page (MyEditScreens.CONFIG)

To specify the sort and fields in the table at the bottom of the Edit Items page, copy the following
section from the items_edit screen in EditScreens.CONFIG and paste it into MyEditScreens.CONFIG.
If you do not perform this step, the Volume and Issue will be included, but the sort will be by ItemID
ascending instead of descending.

<ItemsGrid SortBy="-ltemID">
<Field Name="ltemID" Width="60" />
<Field Name="ItemBarCode" Width="100" />
<Field Name="ltemCopyInfo" />
<Field Name="ItemVolume" Label="Vol." />
<Field Name="Itemlssue" Label="No." />
<Field Name="ltemLocation" />

</ltemsGrid>

e Issue-Only Arrival Pattern for Serials (MyGenie.CONFIG)

To enable the ability to create an issue-only (no volume) arrival pattern using the Set Up Serial Arrival
Pattern screen, add the bold line shown below to MyGenie.CONFIG.

<add key="VolumelssueFormat" value=": v. {v}, no. {i}" />
<add key="IssueOnlyFormat" value=": no. {i}" />
<add key="MovedIssueFormat" value="{d} (expected), {t} (recd): {V}" />
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e Add new Daily Arrival Patterns for Serials (MyGenie.CONFIG)

To add the new daily arrival patterns that omit Sundays or weekends, add the bold lines shown below
to MyGenie.CONFIG.

<SerialFrequency>
<Frequency Pattern="X1" Display="" Default="true" />
<Frequency Pattern="Y1" Display="Annual" />
<Frequency Pattern="M6" Display="Semiannual" />

<Frequency Pattern="D1" Display="Daily" />
<Frequency Pattern="D1 -d1" Display="Daily (no Sundays)" />
<Frequency Pattern="D1 -d1,7" Display="Daily (no weekends)" />
<Frequency Pattern="XX" Display="Irregular" />

</SerialFrequency>

e Specify stop words to use with Alternate Search Syntax feature (MyGenie.CONFIG)

Add the lines shown below to MyGenie.CONFIG, for example, under the existing CurrencyFormat
key.

<!-- Stop word list (used with alternate search syntax) -->
<add key="StopWords" value="a an and by for from in of the to with"/>

e Specify which fields to copy from Catalog to Serials (MyGenie.CONFIG)

This change is only necessary if you want to specify additional fields (other than Title and CatID) to
copy from Catalog to Serials when using the Create Serial Record link on the Serials tab of the Edit
Catalog Record screen. To do so, copy the following section from Genie.CONFIG to
MyGenie.CONFIG, then specify the additional fields. Note that the appropriate Orders field contents
(Supplier ID and Start Date) also are still copied to the new Serial record.

<!-- Map the Catalog fields that you want to copy to the Serials textbase from the Edit Catalog
screen. -->
<CatalogToSerialMap>
<Field Catalog="CatID" Serial="SerCatID" />
<Field Catalog="CatTitle" Serial="SerTitle" />
</CatalogToSerialMap>

e Changes to Print Routing List on Label report (MyLabels.CONFIG)

Copy the LabelRoute3on8.5x11 label from Labels.CONFIG to MyLabels.CONFIG, replacing the
existing copy, then redo any changes you may have made to this label. This will add the Mail Stop to
this label and address a minor formatting issue.

e Add Renew Subscriptions option to Orders section of menu (MyNavbarMenuData.CONFIG)
Copy the bold line shown below into MyNavbarMenuData.CONFIG.

<ltem Id="Receiving_Order" Look-LeftlconUrl="receiving-orders.gif" Text="Receiving Orders"
NavigateURL="orders_Search.aspx?Receiving=true" permission="Administrators
Catalogers"></ltem>

<ltem Id="Order_Renew" Look-LeftlconUrl="order-serials.gif" Text="Renew/Reorder"
NavigateURL="orders_search.aspx?Type=renew" permission="Administrators
Catalogers"></ltem>
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e Add new OPAC Alternate Catalog Search screen (MyQueries.CONFIG)

Copy the alt_opac_search search screen from Queries. CONFIG to MyQueries.CONFIG. Note that
this search screen is not visible by default. See the previous Genie 3.30 Features Not Enabled
section for information on exposing this screen to OPAC users.

e Add new Renew/Reorder search screen (MyQueries.CONFIG)

Copy the orders_renew search screen and the following section (which creates the search screen
drop-down list) from Queries.CONFIG to MyQueries.CONFIG.

<!-- query screen options of a textbase -->
<inmg:QueryScreens TextbaseName="Orders">
<inmg:QueryScreen Name="orders_search"></inmg:QueryScreen>
<inmg:QueryScreen Name="orders_renew"></inmg:QueryScreen>
</inmg:QueryScreens>

e Add Claim History box to Serial Search screen (MyQueries.CONFIG)
Add the following line to the serials_search screen in MyQueries.CONFIG, immediately above the
<QueryField Type="ButtonRow" ... /> line.

<QueryField Type="QueryField" CssClass="SearchTextinput" LabelCssClass="SearchLabel"
ShowBrowse="true" ShowBoolean="true" FieldList="SerClaimHistory" ShowCalendar="true"/>

e Add Routing Information and Link to Borrower Full Display screen (MyReports.CONFIG)
Copy the following changes in the BorrowerFull report from Reports. CONFIG to MyReports.CONFIG.

Add the bold string below to the first line:

<inmg:Report Name="BorrowerFull* ShowManageRouteListLink="true">
Add this new section:

<Seriallnfo Heading="Serials Routed" ShowltemNumber="true">

<Field Name="SerTitle" Footer ="." />

<Field Name="SerCopy" Header=" Copy: " Footer ="." />

<Field Name="SerRouteList" Header=" Routed to: " Separator="; " Footer ="." />
</Seriallnfo>
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e Add new Reports (MyReports.CONFIG)
Copy the following new and modified reports from Reports.CONFIG to MyReports.CONFIG.

LoanOverdueSelect

EmailLoanOverdue

SerialsClaim (replacing the older version)
EmailSerialsClaim

SerialsRoute

EmailSerialsRoute

Routelon8.5x11 (replacing the older version)
SerialsRouteMaint

OrdersRenew

OrdersClaimSelect

EmailOrdersClaim

ALAForm (optional, to print ILL reports)
ILLClaimSelect

EmaillLLClaim

Tip! If you include the ALAForm report, modify the [Library Name], [Telephone], and [Address] strings
at the bottom of the report definition to match the information for your library.

Also, update the <inm:ReportList> sections at the bottom of MyReports.CONFIG for each of the
following textbases.

¢ Add the LoanOverdueSelect report to the Loans section.

¢ Add the OrdersRenew and OrdersClaimSelect reports to the Orders section.
¢ Add the SerialsRoute and SerialsRouteMaint reports to the Serials section.
¢ Create a section for ILL as shown below.

<inmg:ReportList TextbaseName="[LL">

<Report Name="ILLBrief" Display="Summary Report"/>

<Report Name="ILLClaimSelect" Display="Status Check"/>

<Report Name="ALAForm" Display="ALA Request Form" PageName="batch_print.aspx"/>
</inmg:ReportList>

e Modify the Statistics page to use the new checkbox reports (MyStatistics.CONFIG)
Modify the Statistics page to use the new configurable Overdue Notices report for the Overdue Loans
sections. Change each of the occurrences of this tag in MyStatistics. CONFIG:
<View>loansoverdue_report.aspx</View>
To say this instead:
<View Report="LoanOverdueSelect">loans_report.aspx</View>
The default MyStatistics. CONFIG file has four sections for Overdue Loans.

Also, modify the Route Serials section to use the new E-mail Routing Notices report. Change the bold
line below to use SerialsRoute as shown.

<inmg:Statistic Name="route_serials">
<Label>Route Serials</Label>
<Textbase>Serials</Textbase>
<View Report="SerialsRoute">serials_report.aspx</View>
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About Genie Documentation

For a list of the documentation available for the Genie application, see its README file. You received
electronic copies of the Genie documentation set when you installed the application. You will find them in
the Documentation subfolder of the Genie installation folder. In addition, you can access the
documentation set through the Inmagic Customer Extranet at
http://support.inmagic.com/downloads/extranet.html.
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WARRANTY

THE COSTS OF RECOVERING SUCH PROGRAMS OR DATA.

INMAGIC, INC. MAKES NO WARRANTY, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY AND FITNESS. INMAGIC, INC.
SHALL NOT BE LIABLE FOR ANY LOST PROFITS OR ANY OTHER INCIDENTAL OR
CONSEQUENTIAL DAMAGES. IN PARTICULAR, INMAGIC, INC. SHALL HAVE NO LIABILITY
FOR ANY DATA OR PROGRAMS STORED OR USED WITH THIS PRODUCT, INCLUDING

U.S. GOVERNMENT: If Licensee is acquiring the software on behalf of any unit or agency of the U.S.

Government, the following shall apply:
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Contractor/Manufacturer is Inmagic, Inc., 200 Unicorn Park Drive, Fourth Floor, Woburn, MA 01801, U.S.A.

Questions regarding any Inmagic product should be addressed to Inmagic, Inc.

Inmagic, Inc.

200 Unicorn Park Drive

Fourth Floor

Woburn, MA 01801 U.S.A.

Telephone: 781-938-4444 or 800-229-8398
Fax: 781-938-4446
http://www.inmagic.com

support@inmagic.com - technical support questions
CustomerSvc@inmagic.com - general company, product, and services questions
sales@inmagic.com - sales, product pricing, and custom solution questions
wishlist@inmagic.com - feature requests
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